
TSS / SAT Update Summary

Version Date Description Affected Applications

13.01.3138 5/16/2012 New Release All applications

13.01.3138 5/15/2012 Updated installers to put version 8.0.50727.6195, dated 6/27/2011, of msvcr80.dll and msvcr80d.dll in 

TSS_WIN/dynamic.

Installers

13.01.3137 5/14/2012 Updates to SINDA Output Options form in Concap:

  - Initial IDs now default to 1 instead of 0

  - Group box "User Constants" is now "User Defined"

ConCap

13.01.3136 5/14/2012 Concap's LIST/CONDUCTOR was not outputting conductor information.  Fixed by updating GLIST command to 

support /BOTH as an equivalent to /ALL.

ConCap

13.01.3135 5/14/2012 Updated Concap to support the Windows' color names. ConCap

13.01.3134 5/14/2012 Fixed a problem in SindaWin where the Include files were being written in the temp directory instead of the 

work directory.  Also fixed a problem with the icons on the Output tab.

SindaWin

13.01.3133 5/14/2012 Fixed a divide by zero error that would occur if SindaWin was run on a system that had more CPU cores than 

Sinda was licensed for.

SindaWin

13.01.3132 5/7/2012 New Release All applications

13.01.3132 5/4/2012 Corrected a problem where the Dataset form blanks out the previously specified dataset name when selecting 

Cancel.

ConCap

13.01.3131 5/3/2012 The Heatrate file selection dialog will now validate that the orbit dataset in the specified Animation matches 

the selected orbit dataset.

Heatrate

13.01.3130 5/4/2012 Added surface names to error messages. FECC

13.01.3129 5/4/2012 Added surface names to error messages. ConCap

13.01.3128 4/30/2012 New Release All applications

13.01.3128 4/27/2012 Column headers were added to Optics variable property table forms. Geometry

13.01.3127 4/27/2012 Added a new LIST command qualifier/feature named VALIDATION.  This List feature will validate the 

parameters defined for all objects, as well as verifying optics and material property names.  If any 

discrepancies are found, they are listed for troubleshooting.

Geometry

13.01.3126 4/26/2012 Improved the load time performance for Symbol View for models with a large number of symbols defined in 

Geometry.

Geometry

13.01.3125 4/16/2012 New Release All applications

13.01.3125 4/13/2012 Added the new SCIENTIFIC option for the NASTRAN to TSS translator in the GUI as a checkbox. NASTRAN to TSS Legacy 

Translator
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13.01.3124 4/13/2012 Added a new command parameter named SCIENTIFIC to the NASTRAN to TSS translator.  This option will 

output all values translated from NASTRAN using scientific notation in the the TSS Geometry file.  This is used 

so that very small numbers are represented accurately.  Prior to this update, small numbers were being 

converted to zero.

NASTRAN to TSS Legacy 

Translator

13.01.3123 4/13/2012 Updated nastran_to_tss to support FEMAP outputted bulk data decks with scientific notation that doesn't use 

the 'E' format (1.234-7 are treated as 1.234E-7).

NASTRAN to TSS Legacy 

Translator

13.01.3122 4/11/2012 The Command Language help file is now accessible from LaunchPad's context menu via the Other Application's 

submenu.

LaunchPad

13.01.3121 4/10/2012 The 64-bit installer was updated to include 32-bit DLL's required to run 32-bit Legacy applications. Translate

13.01.3120 4/6/2012 Additional application PropertySheets were updated to use a new LIB requirement.  This is a continuation of 

update 13.01.3118.

Animation, ConCap, FECC, 

FEM, Geometry, Heatrate, 

Heatsource, Image, 

launchPad, Mesh, Orbit, 

Radk, SATSTRAN, Transfer, 

XYPlot

13.01.3119 3/30/2012 The TRASYS to TSS Legacy Translator process was modified to use TSS_TIME when creating its temp directory. Translate

13.01.3118 3/30/2012 Command Line processes would not run if the working directory is a UNC path (\\server\folder).  Legacy 

translators and SINDA/FLUINT launch processes were modified to identify UCN paths and to attempt to 

temporarily map the UNC to an unused drive letter (such as Z:) for the duration of process.

Translate and SINDA/FLUINT

13.01.3117 3/26/2012 UNDO now included in Autodraw. Geometry

13.01.3116 3/27/2012 New Release All applications

13.01.3116 3/23/2012  - Added GUI interface for list/node_coordinates command added in update 13.01.3103.

 - Enabled the Object List selection radio buttons on "List Node Correspondence" and "List Node Data" 

    forms.

Geometry

13.01.3115 3/21/2012 Simplification of Linux source code on Windows. Linux Animation, Radk, 

Heatrate, Orbit

13.01.3114 3/20/2012 Updated additional applications to use the new custom ToolTip control. Animation, LaunchPad, 

Satstran, Translate

13.01.3113 3/19/2012 Corrections to update 13.01.3105. Linux Animation, Radk, 

Heatrate, Orbit

13.01.3112 3/19/2012 Updated additional applications to use the new custom ToolTip control. Heatrate, Heatsource, Image, 

Orbit, SINDA, Transfer
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13.01.3111 3/16/2012 Updated additional applications to use the new custom ToolTip control. ConCap, FECC, Mesh, Radk, 

XYPlot

13.01.3110 3/14/2012 Geometry UI enhancements:

 - Updated Geometry to use the new custom ToolTip control.

 - Added a new Tools->Options->Global tab with a control to set the new

   custom ToolTip's display duration.

 - Updated the Comments field on the Object input forms to let the user

   control the row count of the expanded comment field.  Also added the

   ability to always show the comment field expended, or to display it

   in 1 row and expand when active.

 - Added new controls on Tools->Options->User Interface to control the

   comment size and always expanded.

Geometry

13.01.3109 3/12/2012 Created a custom ToolTip control to make it easier to set the ToolTip display duration.  Instead of having to 

manually set each tooltip's duration, the custom tooltip looks up the duration via the registry.

Space3Dcontrols.dll

13.01.3108 3/12/2012 Fixed a problem in the tree where the cached parent nodes were not getting cleared out when the tree was 

cleared out.  This caused problems when the tree was reloaded/refreshed.  

FEM

13.01.3107 2/20/2012 New Release All applications

13.01.3107 2/17/2012 Corrected Triangle surface input form to enable Node ID list for double-sided node numbers. Geometry

13.01.3106 2/16/2012 This update corrects a problem observed in the TSS graphics when the graphics quality is set to HIGH where 

the foreground color of all triangles were not set when constant color mapping is on. 

Geometry, Animation, Radk, 

Heatrate, Mesh, Concap, 

FECC, Transfer

13.01.3105 2/16/2012 Added support routines for Multithreaded programming. All applications

13.01.3104 2/16/2012 Added new BOOLEANS qualifier for the PICK command.  It picks an object as well as all of the booleans 

associated with it.  Format:

                PICK/BOOLEANS object

 

Geometry's tree has been updated to add a "Pick Booleans" option in the context(right-click) menu.  The 

existing "Booleans" option was renamed:

                "List Booleans"

Geometry

13.01.3103 2/6/2012 New Release All applications
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13.01.3103 2/3/2012 Added a node coordinates LIST function to output Sinda node x- y- z-coordinates in specified units.  Currently 

available on Command Line only (view report in the Console).  Will be added to UI soon.

                Command format:    list/node_coordinates/length=uom/all

 

Also updated node data LIST function to have a header record and to also support the optional length 

qualifier.  Length field added to UI.

Geometry

13.01.3102 2/3/2012 Comment fields on object edit forms now always show multiple lines. Geometry

13.01.3101 2/2/2012 This update corrects a problem found in the 3D boolean section of the TSS graphics where the gamma wrap of 

a base 3D surface caused facets to be processed incorrectly. 

Geometry, Animation, Radk, 

Heatrate, Mesh, Concap, 

FECC, Transfer

13.01.3100 1/28/2012 This update corrects a problem found in the 3D boolean section of the TSS graphics where facets could be 

identified as within a boolean boundary instead of outside it when one of the sides of the facet is coincides 

with part of the boolean boundary. This condition can could cause additional facets to become visible when 

they should not.

Geometry, Animation, Radk, 

Heatrate, Mesh, Concap, 

FECC, Transfer

13.01.3099 1/30/2012 New Release All applications

13.01.3099 1/27/2012 Updated SatstranWin to remember the path to the last opened dataset. SATSTRAN

13.01.3098 1/25/2012 Fixed a problem where Orbit would crash when first launched on some system configurations. Orbit

13.01.3097 1/23/2012 New Release All applications

13.01.3097 1/20/2012 Updated the code to handle Booleans for paraboloids. Radk, Heatrate, Mesh

13.01.3096 1/20/2012 Removed ansa.vbs, mkwork.vbs and nastran.bat from installers. Installers

13.01.3095 1/20/2012 Updated Satstran to run under .NET control instead of nastran.bat. SATSTRAN

13.01.3094 1/20/2012 Changed the icon colors for Translate so it would be diiferent than Transfer. LaunchPad

13.01.3093 1/20/2012 Replaced the 'padding' icon in LaunchPad Utilities with Translate (legacy). LaunchPad

13.01.3092 1/20/2012 Added a 'padding' icon to LaunchPad Utilities to keep window size from being too small. LaunchPad

13.01.3091 1/9/2012 Included a better 48x48 icon in for LM Tools in LaunchPad Utilities. LaunchPad

13.01.3090 1/10/2012 New Release All applications

13.01.3090 1/9/2012 Changed LaunchPad's desktop shortcut to read "Spacedesign LaunchPad". LaunchPad

13.01.3089 1/9/2012 Added a Utilities group, containing LMtools, to LaunchPad. LaunchPad

13.01.3088 1/6/2012 Fixed issue where "radks kept" was being output as 0 due to the use of a "long long" integer.  This was caused 

by Microsoft requiring a non-ANSI compatible format prefix of "ll" for printf commands.

Radk
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13.01.3087 1/6/2012 Added checkbox to installer to place a LaunchPad shortcut on the desktop.  Option is checked by default.  Due 

to a bug in Visual Studio, this option cannot be "unchecked" during a command-line (silent) install.

Installers

13.01.3086 12/29/2011 Increased MXLINS (maximum line count) from 20,000 to 2,000,000. SATSTRAN

13.01.3085 12/29/2011 Removed STOP introduced in update 13.01.3063, and added machine type 23 for 64-bit Windows. SATSTRAN

13.01.3084 12/23/2011 This update corrects a condition in the radk contour code where it is possible that two contours could point to 

the same contour set but starting from different vertices. This can cause a fatal error to occur if entire contour 

system is deleted.

Radk, Heatrate, Mesh

13.01.3083 12/23/2011 GUI interface added to Mesh Part form for UNIVERSE, ADJACENT_TEST_ON and ADJACENT_TEST_OFF 

commands added in updates 13.01.3077 and 13.01.3078.

Mesh

13.01.3082 12/23/2011 This update corrects a problem seen in the boolean contour code in Radk and Heatrate where open 

boundaries could be accidently skipped while processing the boolean chain in the contour code.

Radk, Heatrate, Mesh

13.01.3081 12/23/2011 This update corrects a problem seen in the boolean contour code in Radk and Heatrate during the handling of 

the intersection of a base planar surface and a boolean 3D quadric surface when the unbounded intersection 

forms two parallel lines.

Radk, Heatrate, Mesh

13.01.3080 12/23/2011 This update corrects a problem seen in the boolean contour code in Radk and Heatrate where the contour 

base of a base ellipse could be created incorrectly due to the flawed conversion of an ellipse's gamma angles.

Radk, Heatrate, Mesh

13.01.3079 12/23/2011 This update corrects a problem observed within the 3D boolean rendering section of the TSS graphics where 

the failure to properly determine which of two boundaries were nested within the other can cause the 

appearance of a base surface to be incorrect.

Geometry, Animation, Radk, 

Heatrate, Mesh, Concap, 

FECC, Transfer

13.01.3078 12/22/2011 This update adds the ADJACENT_TEST_ON and ADJACENT_TEST_OFF commands to the MESH application's 

command set. The two commands toggle on and off the  checking of surfaces adjacent to each octcell when 

determining its composition so that points and edges between adjacent cells match up more closely. This 

adjacent surface check is new with this update. Neither command has qualifiers or values, the default is ON.

Mesh
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13.01.3077 12/22/2011 This update adds the UNIVERSE command to the command set of Mesh. Prior to this update, the center point 

of the bounding box or universe that surrounded the geometry model and was used as the basis for meshing 

the model was determining automatically. The UNIVERSE command will allow the user to set the center point 

manually. By default, the center point is calculated automatically unless specified otherwise by the user.

To manually set the center point, the user types in:

    UNIVERSE x y z length_unit

where {x,y,z} are the coordinates of the center point and length_unit is unit desire which can be meters, cm, 

feet, or inches.

To reset the automatic center point calculation, the user types in:

    UNIVERSE/AUTO

Mesh

13.01.3076 12/22/2011 Enabled the Screen Output option and the File selection button (the '…' button) on the Radk Output form. Radk

13.01.3075 12/19/2011 This update corrects a problem encountered during the processing of an open boundary in the contour code 

where an endpoint of the boundary that was located on the boundary of a position area was instead 

evaluated as located inside the boundary of the positive area, incorrectly changing the final results. 

Radk, Heatrate, Mesh

13.01.3074 12/16/2011 Multiple updates to FEM:

      - Support for Material properties

      - Save Image to File

      - Map Sets of data over Time, with Gain

      - Database improvements

      - Nastran output improvements

FEM

13.01.3073 12/16/2011 Multiple updates to Sinda:

      - Trapped error when deleting temp directory.

      - Options->Syntax Highlighting has new settings for "Warning"

      - "Run Model" summary now uses Syntax Highlighting settings.

      - Fixed crash when converting an empty text tab into a grid.

      - Grid context menu has new options for:

                   Insert Multiple Rows

                   Add Column

                   Delete Column

SINDA/FLUINT

13.01.3072 12/16/2011 This update removes the remaining periods from the database names used by anim_cl, heatrate_cl, orbit_cl 

and radk_cl on Linux. See also updates 13.01.3037 and 13.01.3038.  This enables cross-platform database 

usage.

Linux Animation, Radk, 

Heatrate

13.01.3071 12/8/2011 New Release All applications
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13.01.3071 12/7/2011 This update corrects a problem observed during the output phase of the Mesh application when an octcell was 

not broken down correctly when instructed to break one of its vertices away. The resulting two pieces has a 

slight overlap in volume due to one the remaining part of the cell not processing a face correctly.

Mesh

13.01.3070 12/7/2011 Renamed manual "Sinda 43C App.pdf" to "Sinda 43C Appendices.pdf". Installers

13.01.3069 12/7/2011 Installer now supports 'silent install' using msiexec /quiet option.  Custom set-up window to copy example files 

was modified  to use radio buttons instead of checkboxes, allowing this step to be overridden.  The commands 

with options are listed below.  Setting OPTIONALSTEP=0 will skip copying the example files.  Setting 

OPTIONALSTEP=1 will copy the example files, causing the custom set-up window to pop-up (requiring user 

input).

     Use this to install in quiet mode for 32 bit:

               msiexec /i winsetup.msi /quiet OPTIONALSTEP=0

      or this for 64 bit:

               msiexec /i winsetup64.msi /quiet OPTIONALSTEP=0

Installers

13.01.3068 12/6/2011 New Release All applications

13.01.3068 12/6/2011 This update corrects a problem found in Concap where the edge coordinates of the three unconnected edges 

in a surface defined as a triangle were not assigned correctly which caused the auto-connect command to 

connect to the wrong triangle edges when triangles are involved.

ConCap

13.01.3067 12/5/2011 Updated Sinda/Fluint version number in SindaWin from 4.6C to 4.7A SindaWin

13.01.3066 11/29/2011 Fixed parsing problem with FAC cards and conductors introduced when the 4 character cards (e.g., SIVF/SIVM) 

were introduced. A FAC card in column 1 would not be recognized.

SINDA/FLUINT

13.01.3065 11/18/2011 Fixed a problem in SATSTRAN where it couldn't find file NASINFO if spaces were in the directory. SATSTRAN

13.01.3064 11/17/2011 Updated the maximum number of (sub)models Sinda can process from 128

to 512. This affects the size of the CNTR file, so previous runs cannot be "restarted" using just the processor, 

but must be run from scratch starting with the preprocessor.  Also Updated version numbers of the 

preprocessor and the processor from v4.6C to v4.7A.

SINDA/FLUINT

13.01.3063 11/15/2011 Replaced ansa.vbs with new version that removes run-time diagnostic messages. Mesh

13.01.3062 11/15/2011 This update corrects an bug introduced in update 13.01.3060 where DEFAULT command in the tssgm file 

output was missing a '=' sign, causing the model loading process to terminate early.

Mesh

13.01.3061 11/13/2011 This update enables the Mesh application to output a log file. Mesh

13.01.3060 11/13/2011 This update adds the UNITS command to the mesh command set which allows the length unit of the output to 

be set and the enables the unit setting in the preferences form to function correctly. The command is based on 

the UNITS command used in Radk and other applications.

Mesh

13.01.3059 11/15/2011 New Release All applications
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13.01.3059 11/11/2011 Updated the GUI Progress Bar to not crash if it receives an invalid value. Heatrate, Image, Mesh, 

Radk, SindaWin

13.01.3058 11/11/2011 Updated Mesh Part form to have a Units Drop Down for the revised MESH command from Update 13.01.3057. Mesh

13.01.3057 11/11/2011 This update adds the UNIT and LENGTH_SIZE qualifiers to the MESH command. The UNIT qualifier allows the 

user to set the length unit of the mesh and the LENGTH_SIZE may be used place of the SIZE qualifier although 

SIZE will be remain available.

Here is the new MESH command definition and format:

MESH/LENGTH_SIZE (or SIZE)={real value}/UNIT={string}/(INSIDE, OUTSIDE, or SHELL)     {part name string}

Purpose – to create a shell or volume mesh based on the objects selected with the PICK function in the Mesh 

application. The resulting mesh will become a part and be assigned a name.

Qualifiers:

SIZE or LENGTH_SIZE – minimum cell size, must be real value greater than zero, if absent from command, 

default value is 0.01

UNIT – length unit string that is applied to SIZE value, valid strings are centimeters, cm, feet, ft, inches, in, 

meters, and m. If absent from command, default UNIT value is “meters”.

INSIDE – mesh volume inside selected objects

OUTSIDE - mesh volume outside selected objects

SHELL – mesh the shell of the selected objects

Keywords:

Part – the name by which the mesh to be created will be associated with.

Mesh

13.01.3056 11/11/2011 Sinda Workspace Files now supports importing of folders.

Added Drag and Drop support for the Workspace Files Tree.  Files are copied by dragging them to/from Sind 

from/to Window Explorer or other instances of Sinda.

SindaWin

13.01.3055 11/11/2011 Fixed a problem where the Specify Node form was not updated if the nodes were modified via the command 

line.

Added the ability to multi-pick nodes on the Specify Node form.  Delete routine updated to support multiple 

nodes.

Radk, Heatrate

13.01.3054 11/11/2011 State of source check boxes were not maintained on the Begin Run form.  This has been corrected. Heatrate

13.01.3053 11/11/2011 Error message files were not loaded in HeatRate.  This could cause the program to crash.  Files are now loaded. Heatrate

13.01.3052 11/10/2011 This update corrects a problem within Mesh where a pair of function pointers that handles mapping between 

the uv space and 'ab' space in the boolean boundaries were incorrectly set for a number of surfaces. This 

condition had the effect of causing a fatal error during the loading of a model into Mesh.

Mesh
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13.01.3051 11/7/2011 This update modifies the COPY command in the Geometry application to support Boolean surfaces.  When an 

assembly is copied, all the logical operations within the original assembly will be duplicated within the new 

assembly.

Geometry

13.01.3050 11/7/2011 This update corrects a problem seen in the TSS graphics when the image quality is set to LOW. It was found 

that some base surfaces that had boolean operations associated with them would draw their node outlines as 

though the image quality was set to HIGH.

Geometry, Animation, Radk, 

Heatrate, Mesh, Concap, 

FECC

13.01.3049 11/7/2011 This update improves graphics speed, addressing reduced performance introduced in the image quality 

command in update 13.01.3042, particularly when the quality is set to HIGH.

Geometry, Animation, Radk, 

Heatrate, Mesh, Concap, 

FECC

13.01.3048 11/2/2011 Added Update Increment to the About window.  This displays the full TSS_Win version number that is 

otherwise accessible via the Control Panel.

GUI applications

13.01.3047 11/2/2011 Enabled Miminize Window in Launchpad.  Minimize button does not show up in a tool window, so use the 

context menu (right click) to access the minimize option.

LaunchPad

13.01.3046 11/3/2011 New Release All applications

13.01.3046 10/31/2011 This update is a correction to update 13.01.3042 where the GLH draw polygon was not setting the edge color 

in one of its branches thus it used whatever the current color was in OpenGL.

Geometry, Animation, Radk, 

Heatrate, Mesh, Concap, 

FECC

13.01.3045 10/28/2011 Added Folders and Icons to the Workspace Files in Sinda.  The Workspace tree is now sorted.

Revised Reference File Open routines to use a SystemFileWatcher toimport changes to files.

New Workspace File Info window accessible via right-click context menu.

Revised error handling when importing files.

SindaWin

13.01.3044 10/28/2011 Updated Display Preferences form to support the HIGH_SMOOTH value for the IMAGE_QUALITY command. Geometry, Animation, Radk, 

Heatrate, Mesh, Concap, 

FECC

13.01.3043 10/26/2011 This update corrects a fatal error encountered while the octcell tree building operation was processing a base 

disc surface with a Boolean chain. It was found that the disc and ellipse surface types use the 3D boolean 

octcell intersection test and a quadric equation data structure that is initialized by all the 3D quadric surface 

types was not initialized for any of the 2D surface types. When the structure was initialized in disc and ellipse, 

the fatal error was eliminated and the octcell tree was completed normally.

Radk, Heatrate, Mesh



TSS / SAT Update Summary

13.01.3042 10/25/2011 This update modifies IMAGE_QUALITY command within the GU command set and also changes how the 

settings will be implemented within TSS graphics and the HGI/GLH libraries. 

First, the graphics invoked by the "IMAGE_QUALITY HIGH" command now will draw the node outline with a "3-

D" line which cause the outlines to stand out more against the solid rendering than the original optimized but 

'2-D' node outline did. The new node outline in this mode will tend to appear jagged however.

Second, a new value has been added to the IMAGE_QUALITY command called HIGH_SMOOTH which will anti-

alias or 'smooth' the node outline when it is drawn. The appearance of the outline is improved but the user 

can potential suffer a time penalty since this method of rendering is slower than either the LOW or HIGH 

image quality values.

Geometry, Animation, Radk, 

Heatrate, Mesh, Concap, 

FECC

13.01.3041 10/10/2011 New Release All applications

13.01.3041 9/30/2011 Added support for multi-line comments for the objects in Geometry. When the comment field is active, it will 

expand to show multiple lines.  Clicking on the form or tabbing to the next field will restore  the comment to a 

single line.  Comments will multiple lines will show a ... after the text box to let the end users know the 

comment has multiple lines.

Geometry

13.01.3040 10/6/2011 This update corrects a flaw in the boolean boundary creation code where a legitimate boundary can be 

accidently clipped entirely away if it is completely coincident with one of the clip planes used to bound a 3D 

base surface.

Radk, Heatrate, Mesh

13.01.3039 10/3/2011 New Release All applications

13.01.3039 9/30/2011 This update corrects a flaw in the 3D booleans in the TSS graphics seen during the process of turning on and 

off facets of an boolean overlay where a flaw in the algorithm could allow a jump across the boolean boundary 

and turn on extra facets in the overlay.

Geometry, Animation, Radk, 

Heatrate, Mesh, Concap, 

FECC, Transfer

13.01.3038 9/29/2011 This update corrects a flaw in the 3D booleans in the TSS graphics where an operation was applied to the initial 

surface boundary instead of just the boolean boundaries. This could cause some of the facets to turn off when 

the initial base surface has a gamma range of 360 degrees.

Geometry, Animation, Radk, 

Heatrate, Mesh, Concap, 

FECC, Transfer

13.01.3037 9/27/2011 New Release All applications

13.01.3037 9/27/2011 This update corrects a flaw seen in the radk boolean boundary code where a composite boundary was not 

redefined correctly if one of the polynomials of the composite boundary was removed during the clip plane 

process which in turn could cause a fatal error during the Radk/HR loading process.

Radk, Heatrate, Mesh

13.01.3036 9/26/2011 Added '.' separator back into individual position files, which had incorrectly been removed previously. Also 

removed an expected '.' when reading a motion file which had been missed. The update affects both the 

command line and gui versions of Animation.

Animation
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13.01.3035 9/23/2011 This update corrects two issues found within the 3D Boolean section of the TSS graphics. First, a correction to 

the boundary sets involving wrap-around flags and extraneous points eliminated a chance for some facets to 

have  ‘sawtooth’ appearance. Second, a flaw in the node outline algorithm used by 3D Booleans was found 

and corrected.

Geometry, Animation, Radk, 

Heatrate, Mesh, Concap, 

FECC, Transfer

13.01.3034 9/22/2011 This update changes the facet and edge definitions of the torus surface type in the TSS graphics from a counter-

clockwise to a clockwise orientation as viewed from the ‘out’ side of the surface, thus matching all of the other 

surface types that are surfaces of revolution. This change is strictly internal and should be transparent to the 

user.

Geometry, Animation, Radk, 

Heatrate, Mesh, Concap, 

FECC, Transfer

13.01.3033 9/22/2011 Added logic to expand the size of bounded sphere objects being transferred from Iges to TSS in Transfer. This 

corrects an issue where boolean boundary surfaces were not always intersecting with graphics facets to create 

a complete boundary.

Transfer

13.01.3032 9/21/2011 Fixed a resize window bug in Orbit that could crop the OpenGL view.

Revised resize routines to better align the checkboxes in Orbit's View Options group box.

Fixed a typo in an error message in Save Image to File.

Animation, Concap, FECC, 

Geometry, Heatrate, Image, 

Mesh, Orbit, Radk XYPlot

13.01.3031 9/19/2011 This update corrects a flaw seen in the 3D boolean graphics which could cause a fatal error. The test used to 

determine whether two points are considered colocated if the coordinates are compared as floats rather than 

doubles did not always work if one pair of coordinates are close to zero. The error was originally found in 

Transfer.

Geometry, Animation, Radk, 

Heatrate, Mesh, Concap, 

FECC, Transfer

13.01.3030 9/19/2011 This update fixes two problem that caused fatal errors during the building of an octcell tree into Radk and 

Heatrate. The first bug involved an uninitialized pointer and counter for keeping track of extended polynomials 

for a boolean surface in a 3D boolean boundary set in the RT database, the second bug involved an extra zero 

variable defined in a 'u = ?' or 'v = ?' polynomial which caused a fatal error with the boundary intersection 

point function.

Radk, Heatrate, Mesh

13.01.3029 9/17/2011 This update fixes a problem seen in the Transfer application where a division by zero caused a fatal error 

within the facet overlay initialization during the meshing process. This initialization is also used in the 3D 

boolean operations of the TSS graphics.

Geometry, Animation, Radk, 

Heatrate, Mesh, Concap, 

FECC, Transfer

13.01.3028 9/19/2011 New Release All applications

13.01.3028 9/16/2011 File Tab brings up a New Tab form for the creation of new workspace tabs.  A file can optionally be imported.

Double-click on an include that does not exist will open the New Tab form with the tab name prefilled.

Find will now find text in Grid tabs.

Context Menu (right-click) added to workspace tabs.  Options are: Info, Rename and Remove Tab.

Header Tree now includes Grid tabs.

SindaWin

13.01.3027 9/16/2011 This update fixes a problem seen in the Geometry applcation when a TSS sphere is defined with a boolean list 

and the number of facets in the Preferences form is set to 200. The point set of the facets located at the apices 

of a sphere were defined incorrectly in the 3D Boolean operations and this incorrect definition would later 

cause a fatal error in HGI/GLH.

Geometry, Animation, Radk, 

Heatrate, Mesh, Concap, 

FECC, and Transfer



TSS / SAT Update Summary

13.01.3026 9/16/2011 This update fixes a problem in Transfer where the trim boundaries of certain surfaces were not changed from 

open loops to closed loops during  the meshing process.

Transfer

13.01.3025 9/15/2011 This update fixes a problem in Transfer where the HGI Polygon Data structure could be left uninitialized in 

function gm_transfer_calculate_surface.

Transfer

13.01.3024 9/14/2011 This update fixes a fatal error observed during the model loading operation in the Geometry application 

caused by attempts to free memory already previously freed within the 3D Boolean section of the TSS 

graphics.

Geometry, Animation, Radk, 

Heatrate, Mesh, Concap, 

FECC, and Transfer

13.01.3023 9/12/2011 New Release - TSS v13.01 Revision C  (3000 series) All applications

13.01.3023 9/12/2011 Fixes a crash in Heatrate due to an uninitialized pointer. Heatrate

13.01.3022 9/10/2011 This update corrects two problems with the GUI of the Heatrate application when it issued commands which 

caused fatal errors when loading a new Heatreate model. The problem was corrected by having the GUI call 

the functions performing a DRAW and FIND command directly instead of processing them as a command. 

Since this is occurring in the GUI’s initialization phase and other actions are called directly instead of through 

the command processor, this modification should not violate TSS GUI protocol.

Heatrate

13.01.3021 9/8/2011 Updates to SindaWin:

           - New Delete Temp Directory option added to Tools->Options form.

           - Updates Find to work with new RunTime tabs.

           - Run Model and Legacy options moved to new Analyze menu.

           - File->Close now prompts for save, plus it now closes the new RunTime tabs.

SindaWin

13.01.3020 9/8/2011 Cosmetic update to banners in SINDA/FLUINT processes SINDA/FLUINT

13.01.3019 9/8/2011 Increased SINDA/FLUINT array size to allow up to 100,000 elements per array. SINDA/FLUINT

13.01.3018 9/8/2011 Corrects an issue where Animation database files were saved with a trailing '.', which is the extension 

separator on Windows. When a Windows database was moved to Linux, it could not be read, as the

 period was not part of the filename.

Animation (Linux)

13.01.3017 9/8/2011 This update modifies the sun right-ascension and sun declination angle calculations by changing the Julian time 

baseline from the year 1900 to the year 2000. This change should produce  a very slight change in the resulting 

values of the two angles but the values should be more accurate.

Orbit, Heatrate

13.01.3016 9/2/2011 Fix minor preferences issue with Legacy form.  Added context menu (right click) to Workspace and Results to 

allow viewing/saving of files.

SindaWin

13.01.3015 9/2/2011 Min flux field on Geometry Map form was incorrectly disabled at times. Geometry

13.01.3014 9/2/2011 Added access to the Application Help files to LaunchPad. LaunchPad

13.01.3013 9/2/2011 Fixed a minor display issue for symbols with lengthy definitions. Geometry



TSS / SAT Update Summary

13.01.3012 9/1/2011 This update adds the 'rev B to rev C' checkbox to the file selection form of the Geometry application. Checking 

this box will modify certain TSS surfaces by switching the logical operators of their Boolean surfaces in the IGIF 

database  from ‘cut’  to ‘ intersection’  or vice versa after the geometry model is loaded into the IGIF database. 

This switching of logical operators is based on a correction to the TSS graphics when displaying the 2D Boolean 

‘slash’ operation to match the Radk application contours.  The modification only affects 3D curved surfaces 

used as slashes on 2D base surfaces.  This operation should be performed only once when moving a model 

from Rev B to Rev C.

Geometry

13.01.3011 8/31/2011 Added GUI for new Animation commands added in update 13.01.3001. Animation

13.01.3010 8/30/2011 Updated installers for new SidnaWin application. Installers

13.01.3009 8/30/2011 Renamed Add Materials/Optics to Import Materials/Optics to make it clearer to the end users that it was a 

different function than Create.  Redid the Import forms to be easier to use.

Geometry

13.01.3008 8/30/2011 New version of SindaWin that utilizes the workspace concept (*.tssws). SindaWin

13.01.3007 8/29/2011 Updated version # and dates of Sinda to reflect corrected licensing (new Intel and AMD processors). Linux SINDA/FLUINT

13.01.3006 8/29/2011 Conversion of Linux Sinda to Eclipse/Photran/G95. Linux SINDA/FLUINT

13.01.3005 8/30/2011 Minor fixes for Linux CL applications build.  This update indirectly affects graphical applications on windows as 

well.

All applications

13.01.3004 8/29/2011 This update allows an open Boolean boundary loop or 'slash' to be a valid operand for affecting a logical 

operation onto a 3D quadric base surface when when processed as a boolean boundary set within 

Radk/Heatrate. Previously, open boundaries were simply discarded when the base surface was a 3D quadric 

type while they could affect the boundary set of a base surface type that was planar.

Radk, Heatrate, Mesh

13.01.3003 9/1/2011 Revision 2 - – the header file igif_protos.h needed to be modified due to a compiler error on release machine. 

The file has been checked-in and has included in the modification list.

Geometry, Animation, Radk, 

Heatrate, Mesh, Concap, 

FECC, and Transfer.

13.01.3003 9/1/2011 Revision 1 - the source file frm_geomui_boolean_options.c was modified but not checked-in during the 

original update announcement and was not included in the modification list.

Geometry, Animation, Radk, 

Heatrate, Mesh, Concap, 

FECC, and Transfer.

13.01.3003 8/29/2011 This update allows an open Boolean boundary loop or 'slash' to be a valid operand for affecting a logical 

operation onto a 3D quadric base surface when displayed in the TSS graphics. Previously, open boundaries 

were simply discarded when the base surface was a 3D quadric type while they could affect a base surface 

type that was planar.

Geometry, Animation, Radk, 

Heatrate, Mesh, Concap, 

FECC, and Transfer.

13.01.3002 8/29/2011 This update implements the paraboloid and hyperboloid as valid base surface types into the Radk boolean 

boundary definitions.

Radk, Heatrate, Mesh



TSS / SAT Update Summary

13.01.3001 8/29/2011 This update adds a set of commands to the command set of the Animation application in order to implement 

the following two new enhancements used when an orbit dataset is input.  1) An option to the Auto-Track 

motion table to allow a user to point an axis of an object to a specific latitude/longitude point on a planet.  2) 

An option to allow the planet to rotate in sync with the current frame number. 

Animation

13.01.2106 8/23/2011 New Release All Applications

13.01.2106 8/19/2011 Fixed typos in error messages. Geometry, Animation, Radk, 

Heatrate, Image, FEM, 

Concap, FECC, Mesh, and 

Transfer

13.01.2105 8/17/2011 This update corrects a fatal error encountered in the Heatrate application when the higher quality graphics 

and the color mapping options are both turned on.

Geometry, Animation, Radk, 

Heatrate, Concap, FECC, 

Mesh, and Transfer

13.01.2104 8/15/2011 This update improves the processor detection and core counting functions to better support newer AMD 

processors.

All applications

13.01.2103 8/15/2011 This update modernizes the TSS command line applications on Linux to Version 13. It also adds support for the 

Eclipse/GCC IDE on RHEL 4.  The update directly affects the command line TSS applications on Linux and 

indirectly affects the Windows version.

All applications

13.01.2102 8/11/2011 This update fixes a problem encountered with the Concap application when during the loading of a CC model 

an error message was displayed indicating that a user conductor was not created in spite of the fact that the 

conductor was indeed created. Debugging the problem revealed three different errors within the user 

conductor section of function cc_create_graphics_object_traverse_conductors(). Once these bugs were 

corrected the error message was eliminated and the user conductor was created and displayed correctly.

ConCap

13.01.2101 8/11/2011 This update fixes a problem in the TSS graphics where 3D TSS surfaces with boolean boundaries were rendered 

as if the boundaries did not exist when the higher quality graphics was turned on but they did render correctly 

with the higher quality graphics turned off.

Geometry, Animation, Radk, 

Heatrate, Concap, FECC, 

Mesh, and Transfer

13.01.2100 8/3/2011 Fixed a problem where the File Fields in the File Dialog  box were not properly appending the *.tss?? Extension 

if the user hit RETURN instead of clicking the OK button.

GUI Applications

13.01.2099 7/12/2011 New Release All Applications

13.01.2099 7/11/2011 Added autodraw to the Setup -> Postprocessing form Concap, FEM, Geometry, 

Heatrate, Mesh and Radk

13.01.2098 5/18/2011 Fixes an invalid property that prevented Debug x64 builds from being made. 64-bit



TSS / SAT Update Summary

13.01.2097 5/13/2011 This update corrects a problem, most likely introduced in update 13.01.2068, where the 3D Boolean code in 

the TSS graphics library would turn off the visibility of all the facets of a base surface if no valid Boolean 

boundaries were in the set. The correct action in this case is to leave the visibility of all the facets of the base 

surface on which the correction now does.

GUI applications

13.01.2096 5/6/2011 GUI updates for Orbit:

                - Under the File menu added options for Save As and Save Image.

                - Under the Setup menu added options for Display Preferences and View.

                - Added the toolbar icons for View Standard Output.

Orbit

13.01.2095 5/3/2011 New Release All Applications

13.01.2095 4/30/2011 Updated license check to use new routines. All applications except 

LaunchPad

13.01.2094 4/26/2011 This update replaces the recursive methods to create and destroy boolean chains in the surface evaluated data 

structure used when converting the IGIF database into TSS graphics data with comparable linear methods. In 

addition, a test was added that allows only a base surface to create its boolean chain within the evaluated 

data structure.

Geometry, Animation, Radk, 

Heatrate, Concap, FECC, 

Mesh, and Transfer

13.01.2093 4/25/2011 Generalized svd algorithm by adding option to remove (or not) singular values. Threshold can be explicit or 

calculated. Also increased points and tolerances for torus.

Transfer

13.01.2092 4/25/2011 Fixed a problem with the Position Override Window where the position numbers were off by 1.  This caused 

the overrides to be displayed/performed 1 position below/less than the actual position specified.  Overrides 

for position 1 were causing an error message (position must be greater than 0).

Animation

13.01.2091 4/22/2011 Fixed a crash condition that would occur if the icons for the "View standard Output" window were missing.  

This was due to a conflict with in-progress work.

Orbit, FEM

13.01.2090 4/18/2011 New Release All Applications

13.01.2090 4/17/2011 Added column headers to HeatRate’s Radiation Force Output. Heatrate

13.01.2089 4/16/2011 The optional legend in Heatrate's XYPlot output had a couple incorrect descriptions.  These have been 

corrected.

Heatrate

13.01.2088 4/16/2011 The wrong qualifiers were being used for the Type-of-data-to-output options on the Radiation Force Output 

screen.  The wrong qualifiers caused all the report variations to be generated instead of just the selected ones.

Heatrate

13.01.2087 4/15/2011 This update corrects a problem in the Heatrate application where the RAD_FORCE command would not output 

the force values unless an enclosure for model.1 was defined beforehand, a condition that is unnecessary.

Heatrate

13.01.2086 4/14/2011 This fixes a problem with the tree auto-expanding when doing a 'resequence node ID'. Geometry

13.01.2085 4/14/2011 Radiation Force Output was missing the File Name Prefix field.  Without the prefix the various reports were not 

being generated.

Heatrate



TSS / SAT Update Summary

13.01.2084 4/14/2011 Fixes in the file dialog:

                - HeatRate Options form showed some garbage in the Options window.

                - TranslateWin showed wrong Window Title for SINDA85 to XYPlot.

Heatrate, Translate

13.01.2083 4/12/2011 This update fixes Nan (Not a number) checking for TSS surface parameters before translating into TSS. Transfer

13.01.2082 4/8/2011 New Release All Applications

13.01.2082 4/6/2011 This update corrects problems encountered when Pick-Hidden-Objects was set to Exclude.

             - hidden objects were picked

              - lag during dynamic rotation

              - CAD method labels and points were not displayed

Geometry, Heatrate, Radk

13.01.2081 4/4/2011 New Release All Applications

13.01.2081 4/4/2011 Correction to routines that update the Active Side in the Tree. Geometry

13.01.2080 4/1/2011 Correction to CHANGE command to improve performance. Geometry

13.01.2079 3/28/2011 Detached Tree View and Symbol View windows now always float in front of the main application 

window(when the windows overlap).  Use Options to disable this and allow the floating windows to appear 

behind the main application window.

GUI applications

13.01.2078 3/28/2011  - Command Line now sets tree to Batch Mode for the CHANGE command.  This improved performance 

dramatically for large models.

 - Command Line now converts Window's Smart Quotes to standard ASCII quotes so copy and paste of 

commands from Outlook, Word, etc. won't crash programs.

 - Added a COPY button to the History window which copies the selected command into the clipboard.

GUI applications

13.01.2077 3/22/2011  - Geometry's GROUP command was fully expanding the tree.  It now only expands the assemblies as needed 

and only if the Auto Find option is turned on.

 - Expand and Collapse buttons have been enhanced - use Shift-Click or Control-Click for enhanced 

functionality:

       no modifier = Expand/Collapse entire tree

        Shift = Expand/Collapse assembly and its sub-assemblies

        Control = Expand/Collapse just the assembly

  - Tooltips added to the Expand and Collapse buttons.

GUI applications

13.01.2076 3/22/2011 Fixed a problem where the tree would get out of sync if the version number was not included for the object 

being renamed.

Geometry

13.01.2075 3/22/2011 Updated boolean tree report (LIST/BOOLEAN_TREE) to include object type in the output. Geometry

13.01.2074 3/22/2011 Fixed a fatal error in Geometry when renaming objects to have a version number that's longer than 7 digits. Geometry

13.01.2073 3/22/2011 Fixes incorrect Tool Tip for SATSTRAN button on LaunchPad. LaunchPad

13.01.2072 3/17/2011 New Release All Applications



TSS / SAT Update Summary

13.01.2072 3/16/2011 Corrected a problem in SINDA/FLUINT and SATSTRAN for checking out a license.  The problem was introduced 

in the 13.01.2070 release, which updated FLEXnet licensing to v11.9.1.

SINDA/FLUINT, SATSTRAN

13.01.2071 3/16/2011 Corrected a problem with the FACETS command to prevent a mismatch of static variables. GUI applications

13.01.2070 3/9/2011 New Release All Applications

13.01.2070 3/8/2011 Flexera USB dongle driver install utility and FLEXnet Publisher v11.9.1 lmutil added to install. Installer

13.01.2069 3/8/2011 Added prefix names for Geometry surfaces created in Transfer.  This will facilitate merging geometry models 

output from Transfer.

Transfer

13.01.2068 3/7/2011 Updated boolean operations to allow an open (“slash”) boolean boundary to be first operation defined in the 

chain.

All applications

13.01.2067 3/7/2011 Updated license routines to FLEXnet Publisher v11.9.1.  This adds support for USB dongles on 64-bit machines.  

Users with 64-bit Windows machines must use v11.9.1 lmgrd/spaced/lmtools and provided dongle driver 

installer.  TSS applications will run using FLEXnet Publisher 11.4.1 lmgrd and 10.8 spaced (except for dongles on 

64-bit OS).  FLEXnet Publisher v11.9.1 lmtools, lmgrd, and spaced added to installer.

All applications

13.01.2066 2/17/2011 Corrected MHAX typo in CAD ->Parameter Replacement -> Maximum Height routine in Geometry. Geometry

13.01.2065 2/17/2011 New Symbol View added to Geometry; updated LIST/SYMBOL output to include evaluated values. Geometry

13.01.2064 2/17/2011 Fixed rename of Assembly bug in Tree routines.  Added Dataset name to detached tree window. Geometry; Tree view 

applications

13.01.2063 2/17/2011 Updated View Standard Output with revised GUI, Font Selection and Print abilities. GUI applications

13.01.2062 2/3/2011 Fixed a Resequence Node ID bug where objects would disappear from the Tree View. Geometry

13.01.2061 2/2/2011 Correction to model loading code in Mesh. Mesh

13.01.2060 1/28/2011 Correction to GLH tessellation source code. GUI applications

13.01.2059 1/26/2011 Fixed a memory leak in Radk octcell tree creation code. Radk

13.01.2058 1/25/2011 New Release All Applications

13.01.2058 1/24/2011 Updated various forms to have a larger color field for showing the longer Windows Color Names.  Fixed some 

routines which were still limited to color names of 10 characters instead of 40.

Geometry

13.01.2057 1/24/2011 Modified Tree, Edit and Right-Click menu to ghost options if tree was out of sync with Picklist.

Fixed problem where copy via Drag & Drop was not selecting the new object in tree.

Fixed a problem where PICks done during *add were not being reflected in the tree.

Geometry

13.01.2056 1/24/2011 USER_COLOR/ADD command was allowing duplicate color names.  Changed to not allow them. Geometry

13.01.2055 1/24/2011 Add quadrilaterals as boolean surfaces in Transfer to cut cones. Transfer

13.01.2054 1/24/2011 Correction for a defect in the 3D boolean graphics in TSS when a cone is rendered with boolean boundary 

passing through its apex.

GUI applications



TSS / SAT Update Summary

13.01.2053 1/24/2011 Eliminate bogus error messages in the Edit menu & Control-Right-Click menu in Geometry. Geometry

13.01.2052 1/24/2011 Remove vertex points from Nurb surface calculations. Add igif tolerance checks to small surfaces in Transfer.  

Bypass boolean surfaces too small to be recognized in Igif.

Transfer

13.01.2051 1/18/2011 New Release All Applications

13.01.2051 1/17/2011 Fixed RENAME problems in Geometry related to the Tree. Geometry

13.01.2050 1/17/2011 Fixed two problems with SAVE command found when using the 'Drag & Drop' feature in the Tree. Geometry

13.01.2049 1/14/2011 Fixed a load-model crash in Geometry.   A range check was added so the progress bar can't be set to an invalid 

value.

Geometry

13.01.2048 1/14/2011 Fixed Windows Color Name support. Animation, Concap, FECC, 

Geometry, HeatRate, Image, 

Mesh, Radk and Transfer

13.01.2047 1/14/2011 Added File -> Save Image added to GUI applications.  This feature was already in Geometry and Animation. ConCap, FECC, Heatrate, 

Image, Mesh, Radk, and 

XYPlot

13.01.2046 1/10/2011 Fixed a nurb calculation in Transfer for a sphere, where Hmin or Hmax > Radius. Transfer

13.01.2045 1/10/2011 New Release All applications

13.01.2045 1/7/2011 Updated Help routines in all apps. GUI applications

13.01.2044 1/7/2011 Fixed Drag & Drop crash bug and an incorrect rectangle error message in Geometry. Geometry

13.01.2043 1/5/2011 Added random points to nurb calculations in Transfer. Transfer

13.01.2042 1/5/2011 Changes to interpolation code in Transfer. Transfer

13.01.2041 1/5/2011 Added ability to override default incoming units in Transfer. Transfer

13.01.2040 1/4/2011 Update to TSS graphics that roughly doubles graphics performance. GUI applications

13.01.2039 12/24/2010 New Release All applications

13.01.2039 12/22/2010 Transfer updates: Fixed a gmin/gmax issue in nurb Cones;  Added user defined EPS for Rational Nurb 

Calculations;  Added user options to run LU, SVD or Both as decomposition options in nurb calculations.

Transfer

13.01.2038 12/22/2010 Fixed convergence issues and mathematics for Booleans and IGES file transfer. Transfer, Radk, Heatrate

13.01.2037 12/22/2010 Fixed problem where Prev/Next buttons in XY Plot weren’t ghosting correctly. XYPlot

13.01.2036 12/21/2010 Added spreadsheet output of XY Plot Data to Heatrate. Heatrate

13.01.2035 12/21/2010 Fixed failure to acquire license if the TSS_LICENSE_FORMAT Environment Variable was defined. All applications

13.01.2034 12/12/2010 Update to Sinda for Linux to accommodate Fortran to C calling conventions SINDA/FLUINT

13.01.2033 12/12/2010 Licensing fixes for Linux and Windows. FLEXlm, all applications

13.01.2032 11/22/2010 New Release All applications



TSS / SAT Update Summary

13.01.2032 11/19/2010 Fixed surfaces to update object labels in Tree when it is in Boolean Mode.  Added new File->Save Image menu 

option in Geometry.

Geometry

13.01.2031 11/19/2010 Linux version of SINDA/FLUINT v4.5C was updated to use the new source tree. SINDA/FLUINT

13.01.2030 11/18/2010 Changes to licensing code, and made Linux licensing compatibility fixes. All applications

13.01.2029 11/15/2010 New Release All applications

13.01.2029 11/12/2010 Added a function stub so CL Orbit could work with new GUI perspective flag. Orbit

13.01.2028 11/12/2010 Fixed minor perspective problems in Animation, added new File->Save Image feature. Animation

13.01.2027 11/12/2010 Added dynamic rotate, zoom and pan to the Animation application. Animation

13.01.2026 11/12/2010 Added perspective command to the Orbit application. Orbit

13.01.2025 11/11/2010 Added dynamic rotate, zoom and pan to the Orbit application. Orbit

13.01.2024 11/11/2010 Fixed a GMIN/GMAX calculation error for the cone in Transfer. Transfer

13.01.2023 11/8/2010 New Release All applications

13.01.2023 11/5/2010 Performance improvement for image capture routines used for Windows printing and clipboard support. All applications

13.01.2022 11/5/2010  Fixed a problem where the GUI Position control in Animation would send a 2nd SHOW command for each one 

encountered in a script.  This would set up a situation where a memory pool ran out, resulting in a program 

crash.

Animation

13.01.2021 11/5/2010 Animation's Object Motion Auto Orbit form has been updated to support the new OUTSIDE_FLAG and 

OUTSIDE_VALUE qualifiers for the LIMIT command.

Animation

13.01.2020 11/4/2010 This update modifies the command set for defining the Auto Orbit Track type of an object motion to allow the 

definition of a default single-axis angle to be used if the calculated rotation angle is not within the specified 

range. The LIMIT command now have the /OUTSIDE_FLAG and /OUTSIDE_VALUE qualifiers.

Animation

13.01.2019 11/4/2010  Users can now control the Architecture flag (ia32/intel64) for the Fortran compiler. SINDA/FLUINT

13.01.2018 11/4/2010 The Border OFF checkbox in Display Preferences did not always turn off the border. Animation, ConCap, FECC, 

Geometry, Heatrate, Mesh, 

Radk.

13.01.2017 11/4/2010 This update fixes a graphics problem in the Orbit application where the planet would be colored black if the 

background was set to white and the planet surface mapping option was turned on. The planet now displays 

correctly.

Orbit

13.01.2016 10/25/2010 Fixed a crash bug on the Boolean Operations form that was caused by trying to sort an empty list of surfaces. Geometry

13.01.2015 10/25/2010 This update modifies the Auto Orbit Track motion option in the Animation application so that it could handle 

any single-axis restricted rotation within the range of -360 to 360 degrees. The LIST command was further 

modified so that the angles printed out are always within the range specified by the motion.

Animation



TSS / SAT Update Summary

13.01.2014 10/25/2010 New Release All applications

13.01.2014 10/22/2010 User tried to have 2078 orbit positions in Orbit.  Updated the program to support up to 3600 orbit positions.  

Also updated the input form to limit the number of positions as you could make more than allowed before.  

Fixed a performance issue with the List Edit form that showed up with 3600 entries.

All applications

13.01.2013 10/21/2010 This update modifies the 'calculated values' option of the LIST command so that an animation matrix that was 

of a form indicating a single y-axis rotation would be printed out as such instead of in the Euler angle format. A 

qualifier has been added to the command to allow the use the original format.

Animation

13.01.2012 10/20/2010 This update corrects the 'calculated values' option of the LIST command so that the rotation angles printed out 

are identical to those written out to the position motion files.

Animation

13.01.2011 10/20/2010 The Status Bar in Animation was not being updated.  This also caused items picked in the graphics area to not 

being selected in the tree view.

Animation

13.01.2010 10/20/2010 This update corrects a condition in the Animation application where the FIND command would not work 

correctly if no graphics was drawn into the HGI graphics tree for an individual primitive object. A correction 

was made in the animation frame bounding box code so it can now handle this condition.

Animation

13.01.2009 10/19/2010 New Release All applications

13.01.2009 10/19/2010 Radk Output was only outputting the first part of the data.  The different sections of the report are output to 

scratch files that are then merged using a DOS COPY command.  One of the files was still open for output 

which caused the COPY to fail to merge the report.

Radk

13.01.2008 10/18/2010 This update corrects a problem in the delete operation of the IGIF name tree where it was not correctly 

redefining the 'parent' pointer of the all data structures in the tree when the tree was being rebalanced. A 

patch function that ensured that the 'parent' pointers were set correctly did not check to be sure that the root 

structure had a NULL value for its 'parent'. The balancing functions were modified so that the 'parent' pointers 

are now reset correctly and the  patch function has been disabled.

Geometry

13.01.2007 10/13/2010 This update corrects a condition in the LIST command where the data retrieved for reflected absorbed is 

overwritten by a second data retrieval, thus allowing erroneous values to be outputted. This error appears to 

occur only for reflected absorbed values.

Heatrate

13.01.2006 10/11/2010 New Release All applications

13.01.2006 10/7/2010 Updated the active sides labels on the Surface Input form to show IN/OUT or DOWN/UP based on the surface 

type.

Geometry

13.01.2005 10/6/2010 Fixed problem in Geometry when multiple moves were done via the Tree.  Fixed problem with tree where 

selecting multiple objects in the tree did not work correctly if you deselected any of the objects.  Added a 

Console Output routine for .Net Strings to add in debugging.

All applications

13.01.2004 10/6/2010 Fixed the transfer to 2D Mesh Boundary Representation option in the Transfer application. Transfer 



TSS / SAT Update Summary

13.01.2003 10/4/2010 This update implements the following changes:  1) All function calls to the graphical structure registration and 

validation functions were removed from the GLH library.  2) The 'delete all structures'  function was modified 

so that the graphical structures are cleared en masse instead of being deleted one by one.

Geometry, Animation, Radk, 

Heatrate, ConCap, FECC, 

Mesh, and Translate 

applications.

13.01.2002 10/1/2010 Fixed problem where Transfer would sometimes hang if started via LaunchPad. Transfer, LaunchPad

13.01.2001 9/28/2010 Fixed problem where Booleans were always showing up when the model loaded even if the Display 

Preferences registry had been set to Boolean Display OFF.

All applications

13.01.2000 9/27/2010 New Release - TSS v13.01 Revision B  (2000 series) All applications

13.01.1012 9/25/2010 Updated ConCap’s Adjust for to support changes made in update 13.01.1010. ConCap

13.01.1011 9/25/2010 Fixed Command Line History Window bug if hitting Recall w/out any history.  Also added Cancel button. All applications

13.01.1010 9/25/2010 Updates to ADJUST command in ConCap: 1) internal nodes may be identified by CC object format.  2) added 

support for user-defined area and length for an unconnected edge.

ConCap

13.01.1009 9/25/2010 Optimization of boundary determination. All applications

13.01.1008 9/25/2010 Additional fixes associated with 13.01.1006. All applications

13.01.1007 9/25/2010 Improved GUI tree performance GUI applications

13.01.1006 9/25/2010 Corrected problem with sphere base surface cut by a Boolean cylinder. All applications

13.01.1005 9/25/2010 Fixed problem with installing to directory other than C:\Program Files\Space3D\TSS_Win.  Fixed crash in 

Animation & Orbit if they couldn’t open planet images or continent information.  Updated tsspath routines to 

use registry for Windows builds.  Orbit now maintains state of Console Window between runs.

Installer, Animation, Orbit

13.01.1004 9/25/2010 Correction to 3D Boolean rendering in TSS graphics All applications

13.01.1003 9/25/2010 Fixed a couple of Fortran projects that pointed to the wrong location for x64 FLEXlm. FLEXlm

13.01.1002 9/14/2010 Fixed fatal error that could occur on ConCap’s Adjust screen.  Tools->Adjust menu option only enabled for 

adjustable objects.  Added Adjust menu option to the SHIFT-RIGHT-CLICK context menu.

ConCap

13.01.1002 9/14/2010 Added License Agreement page to installer. Installer (included in 

13.01.1002)

13.01.1002 9/14/2010 Installers are now being built on Windows 7 platform. Installer (included in 

13.01.1002)

13.01.1001 9/10/2010 Up/Down arrow causing a fatal error. Animation, Heatrate, Radk.

13.01.1001 9/10/2010 Revised bitmaps to correctly fade in over additional screen.  Changed setting so users no longer have to 

uninstall prior version.  Updated information shown on the Support Information 

Installer (included in 

13.01.1001)

13.01.1000 9/9/2010 Official release - v13.01 Revision A (1000 series) All applications


